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General Information 

Welcome to LitePro DLX, this information packet is being provided to help you to work quickly 
and effectively with LitePro DLX. This packet will cover System Requirements, Installation 
Instructions, Basic Settings and Operational Tips. We will also be providing several simple 
tutorials to help you become familiar with the various calculation functions offered by 
LitePro DLX.  

 

System requirements: 

 

• CPU with SSE2 support  

• 4 GB RAM (min. 2GB)  

• DirectX10 graphics card(1 GB RAM)  

• Resolution min. 1024px x 768px  

• Windows Vista SP2 (32bit/64bit)  

• Windows 7 (32-bit/6-bit)  

• Windows XP SP3 (32-bit). No support for Windows XP from 2014.  

• Windows 8 (32-bit/64-bit)  

 

Installation: 

• Start the 32-bit or 64-bit setup.exe file and follow the instructions in the installation 
program. If you have suitable hardware and a 64-bit operating system, then you have 
access to a larger RAM, and it will be possible to create and calculate larger projects in 
LitePro DLX. The 32-bit version should only be used if a 32-bit operating system is 
installed on your computer. 
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General Settings: [File > Settings > General Settings]  

 

 

 

 

 

 

 

 

 

 

General:  
Here you will define how often LitePro DLX should remind you to save your file and set 
the maximum number of working steps that can be undone.  
 

Language Settings:  
LitePro DLX defaults to the language of your operating system. Under "Language 
Settings" you can change the default language and also switch from imperial dimensions 
to metric dimensions. You may also change photometric units from the default Imperial 
System (FC) to the European System (LUX). 
 

Project Preferences:  
Here you can set the default project folder in which your projects will be saved.  
 

More Locations:  
Furniture and materials can be stored on your hard disc or on network drives depending 
on your preference. Here you can set the default locations for your material and objects 
libraries. Only in extreme cases is it necessary to change the storage location. If you 
chose to keep your objects and materials library on a network rather than a local drive 
you must be connected to that network to access them. 

Output Settings: 

 If desired a personal/company logo can be selected for the header on the results 
documents. You also have the option of creating a “Foot Note” that will be shown at the 
bottom of each output document. 

 



6 

Standard Settings: [File > Settings > Standards]  

 

 

 

 

 

 

 

 

 

 

 

  

 

 

General: 

 These setting are preset by LitePro DLX and cannot be changed; however please be sure 
the “Preset” is set to “USA”.  

  

Profiles: 

 LitePro DLX templates are preset and cannot be changed.  

 

Maintenance Value: 

 By setting the default maintenance value to “Detailed” you will be required to provide 
detailed information in each project that is used to calculate the maintenance value. 
When the default is selected the maintenance factor set here will be used on all projects. 
However, the maintenance factor set here can be changed at anytime while creating a 
project. 
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Workspaces: 

 

 

 

 

 

 

 

 

 

 Outdoor and Building Planning: 

 This function allows the creation of a new project with a blank field and no preset 
parameters. Using this function will allow you to create your own project by either 
importing blocks, AutoCad files or “On the Fly” modeling of sites and buildings.   

  

DWG/DXF Import: 

 This function allows the creation of a new project based on the features of a DWG/DXF 
file. After importing the file you will be able to model the site/building by tracing the 
outlines of imported files. 

 

Empty Rectangular Room: 

 This function allows you to create a simple rectangular room based simple dimensions. 
This option will allow you to assign textures to the room, model windows and doors, 
insert objects into the room, add windows and account for day lighting.    

 

Tabular Street Planning: 

 Not Available at this time. 

  

Simple Indoor Planning: 

 This function allows you to create a simple rectangular room similar to the “Empty 
Rectangular Room” tool except that most functions are disabled. You will not be able to 
add objects, windows, textures or calculation results to the room as you can with the 
“Empty Rectangular Room” feature. However, the Workspace Menu will allow you to 
switch from “Simple Indoor Planning to “Building and Outdoor Planning” in order to 
create a more complex calculation. This feature will be used primarily for quick indoor 
calculations and fixture count estimates.  

 

http://en.wiki.dialux.com/index.php/File:New.PNG
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LitePro DLX Interface: 
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Mode:  

 Mode refers to the individual design steps within a workspace. The Mode Menu will 
always be at the top of the screen.  

 

 

 

 

 

Construction Mode: 

 This is the mode you will use to construct your site, building or any other objects you 
may require. Inside of Construction Mode you will be able place furniture, objects or 
create custom objects to use inside of the project. Using this mode you will also be able 
to assign colors, textures and modify the reflectance of the buildings and objects in the 
project. You will use Construction Mode to import, scale or rotate the CAD files that are 
used for the background drawings. 

  

Light Mode:  

 This mode will allow you to import, place and aim luminaires required for the project. 
While in Light Mode you will be able to track energy consumption, energy costs, create 
multiple light scenes, assign individual maintenance factors, create day-lighting 
calculations and place lighting controls into the space. 

  

Calculation Objects Mode:  

 This mode will allow you to place all necessary calculation grids, work zones and activity 
areas that may be required. Calculation Mode will also be used to display the calculation 
results using the Calculation Grids, False Colors or Iso-lines options.  

  

Export Mode: 

 This mode will allow you to export your photometric plan to CAD, render images and 
save views for use later inside of the final documentation. 

  

Documentation Mode: 

 This mode will allow you to assemble the final report for the project. The final 
documentation can include project information, luminaire specification information, 
point-x-point summaries and any views that were saved while creating the design. 
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Tools:  
Each “Mode” provides a different Tools Menu for each function that can be performed 
while in that particular mode. The Tools Menu is always on the left side of the display 
screen. Each “Tool” will have a different Actions Menu that will be used to create, modify 
and/or customize all objects associated with that tool. The Actions Menu is on the right 
next to the Tools Menu. 
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Standard Tools:  

These four design tools on the Tools Menu will be available in Construction, Light and 
Calculation mode. 

       

  

Help Lines and Labeling: 

• Draw Reference Lines: These lines can be used to place objects or luminaires along the 
lines or simply to create a new or missing line inside the DWG file. 

• Draw Help Reference Grid: Used to create grids for placing luminaires and objects at a 
consistent spacing. Used primarily to create ceiling grids inside of rooms to help place 
luminaires. 

• Place New Text: Used to create design notes, luminaire labels or text to identify a 
particular area. The text will be visible in the file and can be exported to the 
documentation or CAD file if desired. This tool will also be used to edit text that is placed 
automatically by LitePro DLX. 

• Draw New Dimension Line: Used to place dimensions inside of LitePro. These dimensions 
will be visible in the file and can be exported to the documentation or CAD file if desired. 

  

Copy and Arrange: 

• Copy along a Line: Allows the selected object to be placed along the line that has been 
created. The length of the line, number of objects and the spacing between the objects 
can be edited after it has been created. 

• Copy as Circular Arrangement: Allows the selected object to be placed along the outside 
of the circle that has been created. The circumference of the circle, number of objects 
and the spacing between the objects can be edited after it has been created. 

• Copy as Polygonal Arrangement: Allows the selected object to be placed along the lines 
of a polygon that has been created. The quantity of objects to be placed along the edges 
of the polygon can be edited after it has been created. 

• Copy along a Curve: Allows the selected object to be placed along a curved line that has 
been created. The quantity of objects to be placed along that line can be edited after it 
has been created. 
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Views: 

• Save New View: Allows the current view from the workspace to saved; the saved view 
can then be imported into the final documentation. 

• Show View: The function will return the current workspace view to the exact camera 
location as the named view you have selected from the saved views menu. 

• Save Image: This function will allow the current workspace view to be exported from 
LitePro as a JPEG image. 

•   

Project Overview: 

• Project Overview: This “Project Tree” will allow you to view all objects in the file you are 
working in. It is most useful in finding objects within the project that may be in conflicts 
with other objects. When you select on the object in the Project Tree the object will then 
be highlighted in the workspace thus making it easier to locate and adjust any errors you 
may have.  

 

View Bar: 

 The different views available will vary based on the type of project and complexity of the 
project being created. As new buildings, stories and rooms are added to a project the 
View Bar will expand providing more options.  
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Site:  

 This view shows you the whole project from an aerial perspective. The Site View will 
include all buildings, parking lots and any exterior objects associated with the site. A 
description of the terrain, a suitable utilization profile, an overall maintenance factor and 
the site location and directional orientation (for day lighting analysis) will be assigned to 
the site here using the Tools and Actions menus.  
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Building:  
Isolates the view onto the selected building, if there are multiple buildings associate with 
a site then a new drop down menu will appear that will allow toggling between the 
buildings. From within this view the building can be named, the active utilization set, the 
building height and number of stories set.   
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Story:  
Isolates the view onto a specified story with the building that is currently active, if there 
are multiple stories associated with the active building a new drop down menu will 
appear that will allow toggling between stories. From within this view the rooms 
associated with specified storey will be created. This view will also be used to create 
doors, windows, cutouts, create roofs, and insert ceilings into rooms. Luminaires and 
sensors may be placed into the space in this view if there is only one room associated 
with the selected story.  
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Room: 

 Isolates the view onto the selected room within the building and story specified within 
previous views (i.e. Site 1/Building 2/ Storey 3/Room 4), if there are multiple rooms 
within a building or story a drop down menu that will allow toggling between the rooms 
will be available. This view should be used to place luminaires, motions sensors, 
furniture/objects, textures, colors and create custom calculation grids if any are required. 
Using the “Assessment Zone” tool in this mode will allow you to name the rooms, assign 
the utilization, set room specific maintenance factors and modify the room height if 
needed. 
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Elevation Views: 

Using the preset views and you can choose to view the project from one of six views.  

  

 

 

1 - 3D Rendering 

2 - Plan View 

3 - Front View 

4 - Side View From Right 

5 - View From Behind 

6 - Side View From Left 

7 - Zoom All 

8 - Tape Measure 

  

Zoom All: 

 Zooms out of the current view too allow for a full screen view of the overall project. 

Tape Measure: 

 Tape measure allows for a quick reference measurement to be done within the design 
space at any time. 

3D Rendering: 

 This view will give a 3-D view of how the project will appear once complete. Any function 
that can be done in “Plan View” can be done in this view as well. The 3D view allows for 
rotation around the site/building/room in all directions to allow the user to get an overall 
perspective of the project. This view is most useful when placing furniture, aiming 
luminaires, applying colors and textures because it allows the user to see how the room 
will appear once complete. 

 

http://en.wiki.dialux.com/index.php/File:Views03.PNG
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Floor Plan: 

 This view gives an overall perspective of the active space from above. The ability to see 
furniture, luminaires and other objects within the space will be based on what Mode is 
currently active. 
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Display Options: 

 

 

 

 

 

 

 

 

  1 - Show/Hide Coordinates System  

  2 - Show/Hide Help Lines  

  3 - Show/Hide Work Plane(s)  

  4 - Show/Hide Calculation Surfaces/Points 

  5 - Wireframe View  

  6 - Show/Hide Isolines  

  7 - Show/Hide Background 

  8 - Show/Hide Photometric Web  

  9 - Show/Hide Room Labels  

10 - Show/Hide Sky Textures  

11 - Show/Hide False Colors  

12 - Show/Hide Textures  

13 – Show/Hide Light Visualization  

14 – Show/Hide Energy Consumption  

  

 

http://poolwiki.dialux.com/images/Options.PNG
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Results Overview:  

 

 

 

 

 

 

 The “Results Overview” menu will automatically open once a calculation is complete. 
Once the calculation is complete all calculation surfaces that are available will be shown 
in the menu. To select a calculation surface simply select “Results on Surface” from the 
Actions Menu under the Calculation Objects Mode and click on the surface or select the 
surface from the Results Overview Menu by clicking on the name of the desired 
calculation grid. Once the surface or work-plane is active it will be highlighted within the 
workspace, then select Iso-lines, False Colors or Calculation Grid from the Actions Menu 
to activate the results.  

 

http://poolwiki.dialux.com/images/Resulttool01.PNG
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Construction Mode:  

• Drawings Tool 

– Import DWG/DXF: Used to load the base file into LitePro DLX. 

– Reload DWG/DXF: Used to update the base file if changes have been made. 

– Drawings: Shows all DWG files that are currently loaded into the program. 

– Active Drawing: Allows the DWG/DXF background to be turned on or off. 

– Scale: Used to specify the units that will be used to create project. 

– Positioning: Allows the base file to be moved and/or rotated to meet a required 
location or orientation. 

– Layer: Allows embedded layers to be turned on or off as needed and also allows 
layer colors to be changed. 

– Save Options: Allows the base file to be embedded into the LitePro file. (Note: If 
the file is embedded into LitePro and the DWG file is updated then LitePro will not 
update with the new background file automatically.) 

• Site Tool 

– Actions: 

• Draw New Building: Used to create single or multi story buildings. Before 
creating the building the total building height and number of stories will 
need to be specified.  

• Draw Floor Element: Use this function to create the floor elements in a 
project. Floor elements are used as calculation surfaces for exterior projects. 
Once created the active floor element can then be assigned a name, 
repositioned or assigned a thickness if necessary. 

• Draw North Arrow: The North Arrow will be used to orient a project to allow 
for daylight analysis to be performed. To create a north arrow simply 
indicate the compass direction by defining two points, the first point being 
south and the second point being north. 

• Duplicate Building: This function enables the duplication of a completed 
building. By removing the tick mark you can decide which features of the 
existing building are assigned to the duplicate building.  

– Active Site: Used to assign a name to site, give a small description of the area and 
determine if there will be outputs for this site.  

– Properties: Used to assign the utilization profile to the site. 

– Maintenance: Used to assign a fixed overall maintenance factor to all luminaires 
that are placed on the exterior portion of a project. 



22 

– Site Alignment: Assign the exact global position of the site using longitude and 
latitude, set the north orientation and assign the time zone for the site. (Required 
for day lighting analysis.) 

– Background: All files AutoCad files that have been assigned to the project are listed 
here. By selecting the file(s) you can choose to remove or update the background 
file. 

• Storey and Building Construction Tool 

– Actions: 

• Draw New Indoor Contour: Used to create individual rooms inside of 
buildings. 

• Draw New Building Contour: Used to create building and/or add onto an 
existing building if required after the original building has been created. 

• New Empty Story: Used to add a new a new story onto the existing building. 
This feature allows for the new story to be larger or smaller than the one 
below it. 

• Duplicate Story: This function allows for the duplication of an existing floor 
level which has already been completed. Specify which features will be 
copied by removing the tick marks beside the objects which should not be 
transferred to the new story. 

• Active Story: Used to name the story and give a brief description of the 
space. 

• Properties: Allows the height and floor thickness of the story to be modified 
if required. 

• Story Overview: Shows the names and heights of each story within the 
specified building. 

• Background: Lists which background files are currently active for the current 
active story. 

• Apertures Tool 

– Actions: 

• Position Active Building Opening: Used to insert apertures (doors/windows) 
into walls or roofs using the cursor. The dimensions of the aperture will be 
shown under the properties menu and can be modified at anytime if 
required. 
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• Draw New Building Opening: Used to insert apertures (doors/windows) into 
walls and roofs by drawing them into position using the mouse. The cursor 
will be used to specify the beginning and end of the opening and then the 
exact length, width and height of the aperture can be set under the 
properties menu. 

• Adjust Building Opening for Wall Thickness: With this function you adapt the 
depth of the aperture to variations in wall thickness. 

• Replace Selected Building Openings: Use this function to replace one or 
more building apertures of the same type with a new aperture in one step. 

• Replace All Building Openings of this Type: Use this function to replace all 
building apertures of the same type with a new aperture in one step. 

• Active Aperture: Displays the current active aperture that will be placed into 
the space. 

• Properties: Displays the Cutting Depth, Height, Width, Frame Width and Still 
Height of the selected aperture. All of these properties can be modified at 
anytime to create a custom aperture. 

• Positioning: Allows the placement of the aperture to be modified 
numerically if needed. 

• Assessment Zones Tool 

– Actions: 

• Draw Rectangular Space, Draw Circular Space, and Draw Polygonal Space: 
These tools are used to create separate zones within a room/area to 
separate areas different criteria from the overall space. The new space can 
then be assigned a new name, utilization profile and maintenance factor.  

• Exclude Subspace: This function allows areas to be removed from the overall 
calculation zone by removing the points within the space from the 
calculation analysis. 

• Active Space: Allows a name and brief description to be assigned to the new 
space. 

• Properties: Allows for a different height and Active Utilization Profile to be 
assigned to the space that is different than the overall space. 

• Workplane: Allows for the name and height of the workplane in the space to 
be set if needed.  

• Maintenance: Used to assign a fixed overall maintenance factor to all 
luminaires that are placed within the space. 

• Positioning: Allows the location of the zone to be modified numerically if 
needed. 
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• Edit Space Contour: Allows for the shape and size of the zone to be modified 
numerically if required. 

• Room Elements Tool 

– Actions: 

• Drawing a Rectangular Room Element, Drawing a Circular Room Element, 
Drawing a Polygonal Room Element: These tools will be used to create 
elements inside of the rooms such as ramps, columns, platforms etc.  

• Active Room Element: Displays the current active room element that will be 
created using the draw tools. 

• Room Elements: These (5) preset elements are what can be drawn into the 
space using the draw tools. Once the objects are placed into the space the 
height, width and length of object can be modified.  

• Positioning: Allows the location of the element to be modified numerically if 
needed. 

• Roofs Tool 

– Actions: 

• Automatically Place Roof: This tool will automatically place one of the nine 
preset roof types, adapted to the contours of the floor level, onto the 
building or story. 

• Draw a Roof: Use this tool to create a custom roof using one of the nine 
preset roof types.  

• Properties: This menu will be used to modify the dimensions, thickness, 
gradient and pitch of the roof after it has been created. 

• Positioning: Allows the location of the roof to be modified numerically if 
needed. 

• Ceilings Tool 

– Actions: 

• Insert Ceiling Into Room: Use this too to create a ceiling that will cover the 
entire space.  

• Draw New Ceiling: Use this tool to create custom ceiling(s) for a space. 

• Active Ceiling: Allows for the height, thickness, plenum depth or wall 
distance for the active ceiling to be modified at any time. 
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• Cutouts Tool 

– Actions: 

• Rectangular Cutout, Circular Cutout and Polygonal Cutout: Use this tool to 
create openings in walls, ceilings, roofs or floors. 

• Properties: Allows for the depth of the cut to be modified to create features 
in the wall rather than openings to the next space. 

• Positioning: Allows the location of the cutout to be modified numerically if 
needed. 

  

• Furniture and Objects Tool  

– Actions:  

• Place by Arrangement:  Use these tools to position multiple objects using 
the specified arrangement type. 

• Draw Extrusion Body: Use this command to create custom objects within the 
active space. 

• Automatic Arrangement for Space: LitePro will automatically populate the 
active space with the defined object and space them at equal distances from 
one another. 

• Replace Selected Building Openings: Use this function to replace one or 
more objects of the same type with a new object in one step. 

• Replace All Building Openings of this Type: Use this function to replace all 
objects of the same type with a new object in one step. 

• Active Object: Displays the current active object to be placed into the 
project. 

• Grid Arrangement: Allows the group of objects placed automatically using 
the Automatic Arrangement for Spaces action to be modified.  

• Properties: Allows for objects with the space to be assigned a specific name. 

• Positioning: Allows the location of the active objects to be modified 
numerically if needed. 
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• Materials Tool 

– Actions: 

• Pick Material: Use this tool to select a material that is currently in the project 
and make it the active material. 

• Apply Material: Use this tool to apply the active material to an individual 
surface or the entire object. (Tip: To apply the material to an entire object 
simply drag and drop the material ball onto the object.) 

• Replace Material: Allows an occurrence of a particular material in the project 
to be replaced with another material. 

• Create Color Material: If the standard colors available do not match what is 
needed then a custom color can be created by adjusting the properties 
under the Color Menu. 

• Create Texture Material: Use this command to import an image file that 
matches the desired texture. 

• Apply Reflectance to Surface: Use the command to adjust the reflection 
factor of a particular surface, color or textured being utilized in the project. 

• Change Reflectance of Room Surfaces: Use this command to adjust the 
reflection factor of the ceiling, walls or floors of a given space.  

• Active Material: Displays the current active color or material that will be 
applied to an object.  

• Advanced Properties: Allows for the Material Type, Reflection Factor and 
Transmission factor of any material to be modified. 

Light Mode: 

• Luminaires Tool 

– Actions: 

• Draw Arrangement: Use these tools to position multiple luminaires into a 
space using the specified arrangement type. Once the arrangement is placed 
it can be modified manually under the “Grid Arrangement Menu”. 

• Place Individual Luminaire: This tool allows for the placement of luminaires 
into an area one at a time. 

• Automatic Arrangement for Spaces: This tool will automatically place the 
required number of luminaire into a space based on the target light levels 
set in the room utilization profile. 
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• Replace Selected Luminaires: Use this function to replace one more 
luminaires with a new luminaire in one step.  

• Replace All Luminaires of this Type: Use this function to replace all 
occurrences of the specified luminaire with a new luminaire in one step. 

• Import Luminaire File: This tool allows IES or ULD files to be imported into 
the project without using the Hubbell Catalog.  

• Active Luminaire: Displays the current active luminaire. 

• Designation in DWG Plan: Allows a designation to be assigned to the active 
luminaire group that will then be exported and displayed in the DWG file. 

• Properties: Allows a name to be assigned to the active luminaire or 
luminaire group. 

• Arrangement: Allows for the current grid, arrangement type, luminaire 
spacing and rotation of the selected luminaire(s) to be modified at any time. 

• Estimate Calculator: Shows the current Target Light Levels and the current 
Estimated Light Levels based on the luminaires that are in the space.  

• Photometric Data: Shows the lumen output, wattage and number of lamps 
for the active luminaire. 

• Mounting Type: Displays the Mounting Type, Suspension Length, Light 
Center Height and Mounting Height of the active luminaire.   

• Lamp Tool 

– Actions 

• Active Luminaire: Displays the current active luminaire. 

• Lamps: Displays the lamp type, lumen output, wattage and color rendering 
of the active luminaire. 

• Edit Joints Tool 

– Actions 

• Set Illumination Point: Use the command to set the aiming point for the 
active luminaire. 

• Reset Angle: Use this command to reset the aiming angle of the active 
luminaire back to nadir. 

• Filter 

– Actions 

• Active Luminaire: Allows for a color filter to be assigned to the active 
luminaire or group of luminaires. 
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• Light Scenes Tool: 

– Actions:  

• Create Light Scene for a Room/Space: Use this tool to can create light 
scene(s) in which only the luminaires assigned to a particular scene are used 
in the calculation. For example, to create an emergency lighting calculation 
assign only the luminaires listed as emergency lights to the new scene. 
When the calculation is run then only the emergency luminaires will be 
considered in the calculation, all other luminaires in the space will be 
ignored.  

• Duplicate Light Scene: This function will duplicate the existing scene to allow 
for the creation of a new scene by adjusting dimmer settings or different 
compositions of luminaire groups. 

• Create Empty Light Scene: Creates a new scene with no luminaires assigned 
to the new scene. 

• Create New Luminaire Group: Creates a new empty luminaire group to allow 
for the creation of a new group with no predefined settings.  

• Assessment Zones Tool: 

– Actions: 

• Draw Rectangular Space, Draw Circular Space, and Draw Polygonal Space: These tools are 
used to create separate zones within a room/area to  

 

• separate areas different criteria from the overall space. The new space can 
then be assigned a new name, utilization profile and maintenance factor.  

• Exclude Subspace: This function allows areas to be removed from the overall 
calculation zone by removing the points within the space from the 
calculation analysis. 

• Active Space: Allows a name and brief description to be assigned to the new 
space. 

• Properties: Allows for a different height and Active Utilization Profile to be 
assigned to the space that is different than the overall space. 

• Workplane: Allows for the name and height of the workplane in the space to 
be set if needed.  

• Maintenance: Used to assign a fixed overall maintenance factor to all 
luminaires that are placed within the space. 
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• Positioning: Allows the location of the zone to be modified numerically if 
needed. 

• Edit Space Contour: Allows for the shape and size of the zone to be modified 
numerically if required. 

• Maintenance Factors Tool 

– Actions 

• Room: Use this menu to define the Room Surface Maintenance Factor or 
change the Assessment Zone the luminaire is assigned to.  

• Luminaire: Use this menu to list the Luminaire Type, set the Cleaning Interval 
and assign a Luminaire Maintenance Factor (LMF). 

• Lamps: Use this menu to list the Lamp Type, Annual Operating Hours and 
Lamp Replacement Interval. 

• Result: This menu will list the final Light Loss Factor (LLF) for the active 
luminaire or luminaire group calculated from the information given in the 
Room, Luminaire and Lamps menus. 

• Energy Consumption: 

– Actions 

• Insert Detector/Sensor: Use this tool to insert a switch or motion sensor into 
a space.  

• Energy Consumption and Cost: This menu will track the current energy 
consumption and energy costs for the active space based on the type of 
switch being utilized, operating hours, absence factor and cost per kw/h. 

• Use Times: Use this menu to set the hours or operation, absence factor and 
utilization profile that will be used in the energy analysis for the space.  

• Tachometer Properties: Use this menu to display an energy/cost usage bar at the bottom 
of the workspace. By setting limits in this menu the usage bar at the bottom of the 
screen will track the usage and notify you when you exceed the preset limits. 
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 Calculation Objects Mode: 

• Calculation Objects Tool 

– Actions: 

• Draw Calculation Object: Use these tools to create new calculation grids 
within the project.  

• Place Calculation Object: This tool will place a calculation zone within a 
larger space. 

• Iso-Lines: Once a calculation surface/grid has become active this button will 
activate the iso-lines for that calculation grid/surface. 

• False Colors: Once a calculation surface/grid has become active this button 
will activate the false colors for that calculation grid/surface. The color limits 
for this grid can be set at the bottom of the workspace. 

• Calculation Grid: Once a calculation surface/grid has become active this 
button will activate the point-x-point results for that calculation grid/surface. 

• Delete Diagrams: This will delete all grids associated with the active 
calculation grid/surface. 

• Results on Surface: Use this tool to select which calculation grid/surface you 
wish to work with. 

• Active Calculation Object: Displays if you are working with a calculation 
object or workplane. (Note: The active workplane can be assigned a name in 
the menu.) 

• Properties: Allow the calculation surface to be given a name with a brief 
description or to set the height and wall zone of the active workplane. 

• Calculation Parameters: Use the menu to assign a calculation type to the 
active calculation grid/surface. 

• Iso-Lines: Use this menu to select default iso-line settings for either an 
“Inside” or “Outside” based on the type of project or to create custom iso-
line settings. 

• Settings for Measuring Grid: Use this menu to set the spacing between the 
calculation points and the placement of the points for the active calculation 
grid/surface. 

• Value Chart Settings: Use this menu to select the font size, rotation angle, 
spacing and placement of the active calculation grid/surface. 
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• Working Planes Tool 

– Actions: 

• Create Working Plane for Space: Allows for a calculation plane to be added 
to space. 

• Iso-Lines: Once a calculation surface/grid has become active this button will 
activate the iso-lines for that calculation grid/surface. 

• False Colors: Once a calculation surface/grid has become active this button 
will activate the false colors for that calculation grid/surface. The color limits 
for this grid can be set at the bottom of the workspace. 

• Calculation Grid: Once a calculation surface/grid has become active this 
button will activate the point-x-point results for that calculation grid/surface. 

• Delete Diagrams: This will delete all grids associated with the active 
calculation grid/surface. 

• Results on Surface: Use this tool to select which calculation grid/surface you 
wish to work with. 

• Active Calculation Object: Displays if you are working with a calculation 
object or workplane. (Note: The active workplane can be assigned a name in 
the menu.) 

• Properties: Allow the calculation surface to be given a name with a brief 
description or to set the height and wall zone of the active workplane. 

• Calculation Parameters: Use the menu to assign a calculation type to the 
active calculation grid/surface. 

• Iso-Lines: Use this menu to select default iso-line settings for either an 
“Inside” or “Outside” based on the type of project or to create custom iso-
line settings. 

• Settings for Measuring Grid: Use this menu to set the spacing between the 
calculation points and the placement of the points for the active calculation 
grid/surface. 

• Value Chart Settings: Use this menu to select the font size, rotation angle, 
spacing and placement of the active calculation grid/surface. 

• Work Areas Tool 

– Actions 
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• Draw Calculation Object: With this tool it is possible to create a separate 
calculation grid/zone inside of a larger space with its own utilization profile 
and target light levels. 

• Condense Surrounding Areas: 

  

• Iso-Lines: Once a calculation surface/grid has become active this button will 
activate the iso-lines for that calculation grid/surface. 

• False Colors: Once a calculation surface/grid has become active this button 
will activate the false colors for that calculation grid/surface. The color limits 
for this grid can be set at the bottom of the workspace. 

• Calculation Grid: Once a calculation surface/grid has become active this 
button will activate the point-x-point results for that calculation grid/surface. 

• Delete Diagrams: This will delete all grids associated with the active 
calculation grid/surface. 

• Results on Surface: Use this tool to select which calculation grid/surface you 
wish to work with. 

• Active Calculation Object: Displays if you are working with a calculation 
object or workplane. (Note: The active workplane can be assigned a name in 
the menu.) 

• Properties: Allow the calculation surface to be given a name with a brief 
description or to set the height and wall zone of the active workplane. 

• Calculation Parameters: Use the menu to assign a calculation type to the 
active calculation grid/surface. 

• Iso-Lines: Use this menu to select default iso-line settings for either an 
“Inside” or “Outside” based on the type of project or to create custom iso-
line settings. 

• Settings for Measuring Grid: Use this menu to set the spacing between the 
calculation points and the placement of the points for the active calculation 
grid/surface. 

• Value Chart Settings: Use this menu to select the font size, rotation angle, 
spacing and placement of the active calculation grid/surface. 

 

• Areas of Activity Tool 

– Actions: 

• Draw Area of Activity: With this tool it is possible to create an activity area 
inside of a larger space to determine the light levels in that specific area 
only.. 
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• Position Area of Activity: This will allow the location of the area to be 
adjusted numerically if required. 

• Iso-Lines: Once a calculation surface/grid has become active this button will 
activate the iso-lines for that calculation grid/surface. 

• False Colors: Once a calculation surface/grid has become active this button 
will activate the false colors for that calculation grid/surface. The color limits 
for this grid can be set at the bottom of the workspace. 

• Calculation Grid: Once a calculation surface/grid has become active this 
button will activate the point-x-point results for that calculation grid/surface. 

• Delete Diagrams: This will delete all grids associated with the active 
calculation grid/surface. 

• Results on Surface: Use this tool to select which calculation grid/surface you 
wish to work with. 

• Active Calculation Object: Displays if you are working with a calculation 
object or workplane. (Note: The active workplane can be assigned a name in 
the menu.) 

• Properties: Allows the type of activity for the current space to defined. 

• Calculation Parameters: Use the menu to assign a calculation type to the 
active calculation grid/surface. 

• Iso-Lines: Use this menu to select default iso-line settings for either an 
“Inside” or “Outside” based on the type of project or to create custom iso-
line settings. 

• Settings for Measuring Grid: Use this menu to set the spacing between the 
calculation points and the placement of the points for the active calculation 
grid/surface. 

• Value Chart Settings: Use this menu to select the font size, rotation angle, 
spacing and placement of the active calculation grid/surface. 

• Room Main Surfaces Tool 

– Actions: 

• Automatically Select Room Main Surfaces: This tool will automatically assign 
a calculation grid to all surfaces associated with the active space. (Walls, 
Floor, Ceiling) 

• Select Room Main Surfaces: Create a separate space inside of a larger space 
that includes vertical calculation grids for the defined space. 

• Select Ceiling Surfaces: 
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• Iso-Lines: Once a calculation surface/grid has become active this button will 
activate the iso-lines for that calculation grid/surface. 

• False Colors: Once a calculation surface/grid has become active this button 
will activate the false colors for that calculation grid/surface. The color limits 
for this grid can be set at the bottom of the workspace. 

• Calculation Grid: Once a calculation surface/grid has become active this 
button will activate the point-x-point results for that calculation grid/surface. 

• Delete Diagrams: This will delete all grids associated with the active 
calculation grid/surface. 

• Results on Surface: Use this tool to select which calculation grid/surface you 
wish to work with. 

• Active Calculation Object: Displays if you are working with a calculation 
object or workplane. (Note: The active workplane can be assigned a name in 
the menu.) 

• Properties: Allow the calculation surface to be given a name with a brief 
description or to set the height and wall zone of the active workplane. 

• Calculation Parameters: Use the menu to assign a calculation type to the 
active calculation grid/surface. 

• Iso-Lines: Use this menu to select default iso-line settings for either an 
“Inside” or “Outside” based on the type of project or to create custom iso-
line settings. 

• Settings for Measuring Grid: Use this menu to set the spacing between the 
calculation points and the placement of the points for the active calculation 
grid/surface. 

• Value Chart Settings: Use this menu to select the font size, rotation angle, 
spacing and placement of the active calculation grid/surface. 

 

Export Mode: 

• Views Tool 

– Actions: 

• Save New View: This tool allows for the creation of custom views that can be 
saved and imported to the final documentation for the project. The saved 
view can also be used to save views inside of LitePro that you may wish to 
return to later, when the saved view is double clicked on the active 
workspace will change to match saved view. 
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• Show View: This tool will change the view in the active workspace to match 
the saved view that has been selected. 

• Save Image: This will allow the current view to be exported from LitePro as 
an image file. 

– Raytracer Tool 

• Start Raytracing: This tool will begin the image rendering process, note that 
image resolution can be adjusted under “Properties”. 

• Cancel: This will cancel the current rendering process. 

• Save Image: This will allow the rendered image to be saved as an image file 
for use outside of LitePro. 

• Create and Save HDR: With the aid of the raytracer LitePro can generate HDR 
images (High Dynamic Range). The spread of luminance which can be 
displayed by your monitor will seldom achieve absolute reality. The actual 
illuminance distribution can however be calculated by LitePro and saved as 
an .EXR file and can then be used in other HDR editing programs. 

– Drawings Tool 

• Export to New File: This will export the photometric plan from LitePro and 
create a new DWG file for the project. 

• Export to Existing File: This tool will export the photometric plan onto an 
existing DWG file, such as the file that was imported to be used as the 
background inside the project. When exporting the file it is possible to 
specify what information will be exported by simply checking the box next to 
the item you wish to export. 

 

Documentation Mode: 

• Selected Outputs Tool: This tool gives a list of all available output information for the 
project. By clicking on the dropdown menu beside the space a list of available 
information will be given. By clicking on the title of the information a preview of that 
document will be shown, by checking the box beside the desired information it will be 
included in the final documentation.  

• Print: This will allow the final documentation for the current project to be assembled, 
printed or saved.  
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• Project Information: This menu can include all necessary information about the project 
for your records. The information provided here will be visible on the cover page of the 
final documentation. 

• Configure Templates: This tool allows for the creation of custom templates that can be 
saved and reused on a regular basis.  
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Keyboard Shortcuts 

• F1 = help 

• F2 = coordinates system on/off 

• F3 = help lines on/off 

• F4 = user planes/areas on/off 

• F5 = wire mesh view on/off 

• F6 = iso-lines on/off 

• F7 = DWG on/off 

• F8 = light distribution curve on/off 

• F9 = global false colors on/off 

• F10 = selection menu bar 

• F11 = report translation error 

• F12 = save as 

• Cut = Ctrl + X 

• Copy = Ctrl + C 

• Insert = Ctrl + V 

• Set focal width of camera = Alt + right mouse button 

• Insert at mouse/cursor position = Ctrl + M 

• New project = Ctrl + N 

• Open= Ctrl + O 

• Save = Ctrl + S 

• Print = Ctrl + P 

• Undo = Ctrl + Z 

• Redo = Ctrl + Y 

• Delete = Delete 

• Cancel Toggle = Shift 
 
Control With Touchpad:  

• Zoom = Z + left Touchpad button 

• CAD Pan = P + Left touchpad button 

• Forward = W 

• Left = A 

• Back = S 

• Right = D 
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